
QlikView Scalability Tools for 
load/performance testing 

This document describes how to create a JMeter script and run a test execution. This version of the 

QlikView® Scalability Tools support creating load/performance tests for QlikView 10, 11, 11.20, and 

12. It is important that any user of the script generator reads this document prior to initiating a test 

session. 

Note that scripts for QlikView 10 work, but are no longer maintained (that is, updated or improved). 

NOTE: The application and parts of the QlikView Scalability Tools package is not supported by 

Qlik®, so use it at your own discretion. 
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Quick Start 
This QlikView Scalability Tools package consists of different sub-packages that are used for 

completing a test session. This section provides an overview of the steps needed to perform a load 

test session and can be used as a checklist for those who are familiar with the tools. If this is the first 

time you are using the tools, it is recommended to read the complete documentation. 

Note: Check the Prerequisites.docx document for the necessary preparations before you start 

working with the QlikView Scalability Tools for the first time.  

1. Use the GUI application, which is located in the ScriptGenerator folder, to create the test 

scenario. 

a. Start QlikViewTestScriptGeneratorGui.exe. 

b. Create a high-level definition of how the test should execute and how each end user 

should interact with the QlikView document. 

c. Save the scenario. 

2. Script Generation: This step should be completed with the GUI application in the 

ScriptGenerator folder. 

a. Translate the high-level XML definition into an executable JMeter script by selecting 

the Generate Script option. 

3. Executing JMeter scripts: This step should be completed using the GUI. 

a. Start the Performance/load test using the Execute all scripts option to load the 

target machine. 

4. Log Collection: After running a test it is usually time to analyze the test results, which means 

that log files from various services are needed. The log files can either be copied manually to 

the required folders or you can use the log file collection helper. 

The log collection is intended as a helper, and cannot be guaranteed to find and fetch the 

files. Firewalls might hinder the tool to find the performance counters (server logs). In 

addition, the user that runs the collector needs administrator rights to the folders that 

contain the log files. Knowledge of what should be collected should be seen as a prerequisite 

to use the log collector. 

When a test has finished, a popup appears, asking if the log file collection helper should be 

launched (see below). The log file collector can also be started from the Tools menu. 

 

Once launched, the tool scans for log files relevant to the test, using input from the script 

(document URL and execution date). The tool will try to find paths to performance counters, 

event logs, session logs and the JMeter log file for the specified timespan. The timespan can 

be adjusted, and you can also change the server(s) that log files should be collected from. If 

anything is adjusted, this needs to be scanned by clicking Scan for the section that was 

updated. Adding a new QVS instance and clicking Scan causes the tool to check for any log 
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files on that newly added instance, and if anything is found it will show up in the Paths to log 

files window. 

 

Log file Collection main window, with found paths to all relevant log files 

If everything is found, all sections in the window are populated with information of where 

the log files are. The next step is to actually fetch the log files by clicking Fetch. Fetched files 

are put in a folder identified by the username and timestamp in the Analyzer folder. All files 

are put in the correct places according to the folder structure used by the Analyzer 

application (JMeter log files are put in JMeterLogs etc.). By default, the JMeter file is moved, 

whereas all other files are copied to the destination folders.  
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If anything goes wrong or log files are not fetched, the Log tab might indicate the issue. For 

example, the following error message is caused by not having administrator rights on the 

server. 

 

5. Analysis of test results: Analysis is performed using the Scalability Results Analyzer tool, 

which is available at https://community.qlik.com/docs/DOC-15451. For more information, 

see the documentation for the package. 

a. Collect the Server description via the ServerMetaFetcher.qvw document or Get 

server info in the GUI application. 

b. Group test results (logs) and create a QVD for further analysis with the QVD 

Generator.qvw document. 

c. Analyze the test results with the SC_Results - *.qvw document. 

Components of the tool 
The QlikView script generation tool package consists of three separate parts; a script generator, a 

script executor and a QlikView document for analyzing test results. A description of each part and 

how to use it is provided in the respective subsection in the User guide section. 

Functional overview 
This section lists the functionality supported by the script generator. 

Actions/selections: 

• AccessPoint entry 

• Open document 

• Button click 

• Change tab within container object 

• Change sheet 

• Chart 

o Randomize zoom area from file (seeded) or unseeded 

• Clear all 

• Clear selections in object (list box, multi box) 

• Select Excluded 

• Select All 

• Select Possible 

• Cycle Chart 

• Cycle Straight Table 

• Document Chaining (triggered from a button) 

• Fast Change (for charts) 

• List box selection(s) 

o Static selection 

o Randomize from file (seeded) or unseeded 

https://community.qlik.com/docs/DOC-15451
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▪ Randomize amongst enabled, disabled or any value 

• Multi box selection(s) 

o Static selection from values corresponding to certain row 

o Randomize from file (seeded) or unseeded 

▪ Randomize amongst enabled, disabled or any value within a certain row 

• Search in search object and select from the results 

o Static selection 

o Randomize from file (seeded) or unseeded 

▪ Randomize amongst enabled, disabled or any value 

• Select a Bookmark 

o Static selection 

o Randomize from file (seeded) or unseeded 

• Straight table 

o Randomize selection from file (seeded) or unseeded 

• Table box 

o Randomize selection from file (seeded) or unseeded 

• Text object click 

• Activate minimized object 

• Add Note 

• Close session 

• Copy Object 

• Create Bookmark 

• Delete user added objects 

• Minimize Object 

• Paste Object 

• Remove Bookmark 

• Send to Excel 

• Export (CSV) 

• Export (CSV) Container 

• Toolbar actions 

o Clear all, back, forward, lock all selections, unlock all selections, show/hide current 

notes, show/hide notes 

Functional components 

• Support for tuning the amount of simulated concurrent users and duration/iterations per 

user in a script 

• Sub-Loop 

o Loops can be created to have a subset of the selections loop a defined number of 

times 

• Timer delays, for simulating user think times between clicks/selections 

o Gaussian distribution 

o Uniform distribution 

o Constant time 
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• Header parameters to allow simulation of different users when not using Windows 

authorization 

o Reading Name and password from file 

• Support for handling documents with Section Access  

o Reading Name and password from file 

• Use of reduced documents list 

o Reading document names from file, which allow generating requests towards several 

reduced versions of a larger document (that is, created by loop and reduce) from 

within a single script.  

• Support for creating and running of regression test scripts (see the documentation for the 

Regression Testing Tool for more information). 

• Support for creating placeholder actions: Prepare empty actions in the script that can be 

edited in JMeter to fit current purpose. Used in case an action is not supported in the 

Scalability Tools. 

Important information about the tool 
The main purpose of the QlikView script generation tool is to provide the ability to create scripts for 

load/performance testing in an easy manner. Note that the tool contains limitations that must be 

considered when creating your script. 

Known limitations 

• Not all QlikView functions can be simulated (see the Functional overview section for a list of 

the functionality that is covered). For scripts covering additional/tweaked functionality, 

modifications must be done directly in the JMeter script. 

• A script simulates requests to one QlikView document, except when reduced document 

functionality is used. Running a test against multiple different documents requires multiple 

scripts, where each script needs a separate JMeter instance.  

• A sub-loop cannot encapsulate another sub-loop. 

• A sub-loop must start with a request not requiring any extraction from a previous request. 

Having sub-loops starting with a Clear All action is good practice. 

• A rich script generated by the generator consumes a significant amount of resources from 

the machine running the JMeter instance. This might result in limitations in the JMeter 

capacity when it comes to the amount of concurrent users that can be simulated without 

triggering a heap memory exception. The solution is to run parallel instances on large 

machines. 

• The Randomize from all selection method should never be used on a document that displays 

a subset of data for different users (that is, Section Access). It is possible to randomize a 

selection, but that selection may not be valid for that particular user.  

• For document paths and names a-Z, 0-9, Space, underscore and dash are supported tokens. 

• Cycle (Chart, StraightTable) actions are not supported for charts within container objects.  

The tool does not validate that your script makes sense. For example, if the Activate Minimized 

Object action has been used for a certain object once, a new Activate action does not activate it 

again. Therefore, Activate Minimized Object actions should be avoided in test-loops. See the 

Recommendations and guidelines for script design section for more information. 
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User guide 
The user guide describes all steps that need to be taken from the point of defining a scenario to 

running the script and analyzing the results. Some general information about performing a load test 

can be found in Appendix B: Load testing – A brief introduction. 

Note: Check the Prerequisites.docx document for the necessary preparations before you start 

working with the QlikView Scalability Tools for the first time.  

Launching Scalability Tool 
The package provides you with the ability to define and generate scripts from a GUI. Start 

QlikViewTestScriptGeneratorGui.exe, which is located within the ScriptGenerator folder.  

 

The main elements of the application window are: 

• Title bar: Displays information on the current document/script. “Untitled Document” 

indicates that the script is new, “*” that it has unsaved changes. When the script is saved the 

script name is displayed instead.  

• Menu bar 

o File: Basic file operations (New, Open, Save, Save As, Exit). 

o Tools: See the Tools section. 

o Help: Provides information on the GUI and help (including a quick link to this 

document). 

• Tool bar: Contains icons for New (file), Open (file), Save, Help, Generate script and Execute all 

scripts. 
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Tools 
The Tools menu provides the following options: 

• Generate Script: Generates the current scenario. 

• Compare Regression Script Results: Allows comparison of results from two tests (for more 

information, see the Regression Testing.pdf document). 

• Log Collection: 

o Collect log files: Launches the log collector (see the Log Collection section for more 

information). 

o Create local folder structure: Creates the folder structure that is needed to analyze 

results (same functionality as manually unzipping FolderTemplate.zip). 

• Get server info: Fetches server information such as #Cores, Ram etc. and saves it in 

ServerInfo.xml (same functionality as if using the ServerMetaFetcher.qvw document, but for 

one server at a time). 

• Edit Settings: 

o jmeterpath: The path to the JMeter bin folder. 

o heapsize: Sets the heap size (integer) used by JMeter. 

o enableLogCollection: Enables (“true” or “1”) or disables (“false” or “0”) the log 

collection functionality. Needs a restart of the Scalability Tools to take effect. If 

disabled, log collection can be launched from the Tools menu and no log collection 

popup appears after a test. 

o enableLogCollectionPopup: Enables (“true” or “1”) or disables (“false” or “0”) the log 

collection popup after each test execution. 

o enableVerbosiveGenarator: Enables (“true” or “1”) more log output after a script file 

has been generated, which can be useful for troubleshooting. Disabled (“false” or 

“0”) by default. 

Define Test Scenario 
The application window contains three tabs:  

• Properties: General properties defining how the script should run. A detailed description of 

the tab is available in the Define Properties section. 

• Scenario: This tab allows adding actions to create a scenario that defines the user behavior 

for the script. A detailed description of the tab is available in the Define Scenario section. 

• Execution: Previously created scripts can be executed from this tab. A detailed description is 

available in the Executing JMeter scripts section. 

Define Properties 
The Properties tab describes the document to run the script against, and settings for the script when 

it runs. 
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Configure Settings 

 

• Method: Allows selection of available script creation methods (currently only JMeter). 

• QlikView Version: Defines the QlikView version for the documents against which the script 

should simulate load.  

• Script Type: Allows selection of available script types – LoadScript, which is covered by this 

document, and RegressionScript, which also requires information found in the Regression 

Testing documentation. 

• Document URL: Paste the URL for the document against which you want to run your test. To 

find the document URL, browse to the AccessPoint and open the document. When the 

document has opened, copy and paste the complete URL. 

Configure Run settings 

• Concurrent users: Amount of concurrent users that the script should simulate. Allowed 

values are positive integers. 

• Iterations per user: Number of iterations that all actions in the script should be performed by 

each user (thread). Note that a new session will be created for each iteration. If multiple 

iterations are set, each user will start again with the first action in the script after it has 

performed the last action. Iterations per user can be set to infinite by selecting the checkbox. 

If iterations are set to infinite, duration needs to be defined. 

• Ramp up: Time in seconds needed to start all threads (users). A Ramp up value of 30 and a 

Concurrent users value of 10 means that one user (thread) is started every third second. 

Allowed values are positive integers and should at the minimum correspond to the 

Concurrent users value. 

• Duration: Time in seconds that the script will run. Allowed values are positive integers. If no 

time limit is desired, select the Infinite checkbox. If the duration is set to infinite, infinite 

Iterations per user cannot be used. 

Note: The script stops either when Iterations per user or Duration has been reached (whichever 

occurs first). It is recommended that only one of these parameters are infinite,  and therefore the GUI 

will toggle between which one of these parameters is set to infinite. 

Configure Variables 
The Variables section describes file names and paths to files that are needed to run the tests. Each 

variable has default values that can be changed. However, it is recommended to use the default 
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settings as these are pre-defined for the package to run out of the box. The default parameters are 

shown below. 

 

• Use Reduced Document list: This option allows a single script to generate load against 

multiple documents where each is a reduced version of a larger document. By default, this 

option is disabled. If enabled, each thread uses a document name from a file rather than the 

one defined in the URL. The text box specifies the file path and name to this file and defaults 

to ..\SupportFiles\doclist.txt, but may be changed, if desired. Each row in this file should 

contain the document name of one of the documents that the scripts should send requests 

to. Insert names of all documents to be tested, having one document name per row. Each 

newly started thread/user will send requests to the document name that is next in line (that 

is, not used) in the document file. 

For example, the document name DemoApplications/Online_Sales.qvw defines the 

document name in the URL below: 

http://servername/QvAJAXZfc/opendoc.htm?document=DemoApplications/Online_Sales.qv

w&host=Local 

If three variants of this document have been created, docList.txt might contain three rows as 

follows:  

DemoApplications/Online_Sales.qvw 

DemoApplications/Online_Sales1.qvw 

DemoApplications/Online_Sales2.qvw 

 

If one of the files should be accessed more often than the others, this ratio may be adjusted 

by having the document appear on multiple lines in the document list. Inserting an additional 

row with DemoApplications/Online_Sales1.qvw from the example above means that this 

document will be accessed by 50% of all threads. 

 

• Log file: Path and name of the result file that is generated from the test. The name of the log 

file can be changed if preferred, but it is recommended to use the default value if the 

analysis tools supplied with this package is to be used. The default value is created using the 

name of the script file, the name of server used to access the document, and thread settings 

(threadcount, rampup, loopcount) and ends with a timestamp for when the script starts. The 

timestamp is only applied correctly when executing the script via the executer provided in 

this package. By default, the log file is written to the folder ..\Analyzer\JMeterExecutions\. 

 

• Seed file 1 & 2: The path and name of files that contain pre-generated seeds that will be used 

when randomizing selections in objects. It is fine to use other files with seeds, but in that 

case they must follow the structure of the existing ones. By default, these can be found in 

..\SupportFiles\. 
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Configure Security settings 
The Security settings need to be correctly set according to the type of authentication that has been 

set up in the server environment. The following options are available: 

• Section Access: If access to the document against which the tests should be performed is 

restricted by Section Access, select this checkbox. Furthermore, specify the path to a file 

containing the user IDs and passwords needed to access the document. Each row in the file 

should contain a user ID and password, separated by “;”. The default path and file name of 

this file is ..\SupportFiles\sectionaccess.txt. 

 

• NTLM: Select this checkbox if the server environment is configured to authenticate using 

NTLM. This means all virtual users will be seen as coming from the account that is running 

the load test, so the account running the load test needs to have access to the environment. 

Even if all virtual users are created from one account, they will still be treated as separate 

users with separate sessions in QlikView. This is the default authentication option.  

• Header: This option should be used if the environment is configured to use header 

authentication. If this option is selected, a path to a file with correct values for the header 

needs to be provided. The file should contain one header value per row. By default, the file 

is..\SupportFiles\usrpwd.txt. In addition, the name of the header (for example, “QVUSER”) 

needs to be specified.  

• Anonymous: This option can be used instead of authenticating using Windows 

authentication. With this enabled, all users will be logged in anonymously, but authenticated 

by supplying username and password (Basic Authentication). A path and file name to a file 

containing these usernames/passwords need to be provided. Each row in the file should 

contain the username and password for one user, separated by “;”. By default, this file is 

..\SupportFiles\bafile.txt. For this to work, the test environment needs to be configured (see 

Appendix C: Setting up Basic Authentication for instructions). 

Note regarding Security settings 

When performing a test, each session in the simulation must adhere to the same rules as any other 

user. The rules can be divided into the following steps: 

• Authentication: “Who are you?”  
QlikView trusts the external component that is responsible for this task. Default is NTLM 
(Windows), but it can also be HTTP header authentication.  

• Authorization: “What are you allowed to see?”  
By default, this is managed by the Windows Security settings (NTFS) for the folder or files in 
the root or mounted folders. It can be managed by QlikView by switching to DMS mode in 
the QMC. 

• Licensing: “We know who you are and that you are allowed to see this QVW, but do you have 
a license?” 
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This is handled by QlikView Server. If the user does not obtain a license, by following the 
licensing rules, the user will not get a session. 

• Section Access, if applicable: “Do you have credentials for this data?” 
This is based by on the document setup. 

Failing in any of these steps will render the simulation faulty and not suitable for analyzing.  Either 

you can change the server configuration to suit the test, change the test to suit the configuration or 

do a mix of both. 

The default JMeter behavior is to connect to QlikView Server with the NTLM user who started it. This 

works in some cases, but Named CALs do not accept multiple sessions with different session cookies 

for the same username and QlikView document. Ensuring that other licenses are used instead might 

solve this, but there are other options as well. Configuring to use DMS mode and header 

authentication is one option. The test scenario must then be configured to use Header 

authentication, with the usernames in a text file. This will ensure that unique users connect and as 

long as each user is assigned a CAL the simulation will work. 

Define Scenario 

The test scenario is defined in the Scenario tab, which consists of a Settings and an Actions section.  

Settings 
This section consists of three types of settings. The settings are mainly informative or helpful for 

scenario creation, but not strictly mandatory to use. This section may be hidden by clicking the arrow 

next to the Settings heading, which gives a bit more room for the scenario actions. Click the arrow 

again to display the hidden section. 

• Run Settings: These are the same as defined in the Properties tab. 

• Import QlikView Document: The GUI provides the option to define a scenario by using the 

document layout/project files. These files are used by the GUI to allow and simplify selecting 

object names and other parameters from drop-down lists when defining the scenario. It is 

possible to define a script by manually by entering object names and parameters, but to 

avoid script issues due to typos etc. it is recommended to use document layout files when 

creating a script. To create project files, open the QVW document in QlikView Desktop. 

Choose File > Export > Export Document Layout… Select the folder in to save document 

layout and click OK. To read the files, click Browse and go to the folder in which the files 

were saved from the GUI. If any change has been done to a script without saving it before 

importing project files, a prompt appears, requesting the file to be saved in order to import 

the project files. The file path is displayed in Italics until successfully imported. 

• Auto Timer: It is highly recommended to always include timers (“think times”) between 

actions performed in a scenario. By default, a uniform timer with 30-35 seconds think time is 

inserted between actions. The type of timer and the settings for it can be modified, as can 
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the option be turned off completely. Each individual timer can be modified if any should 

differ from the automatically added one. 

 

Actions 
The scenario is created by selecting the actions to be performed from the Action drop-down list. 

Depending on the type of action selected, additional parameters may be required for the action to be 

properly simulated. A scenario should start with an AccessPoint and/or Open Document action. To 

insert additional actions in your script, use the green  button (shift+   inserts an action above the 

current). To remove an action, use the red  button. 

Next to each action in the scenario there is a checkbox that enables or disables the action. Disabled 

actions are greyed out and will not be included in the finished script once it is generated.  

 

As mentioned, some actions have additional parameters that must be defined to get a working script. 

The most common parameters for the actions are: 

• Label: An identifier of each action that will primarily be used to differentiate the actions in a 

scenario when analyzing the results. Providing label is not mandatory. The default value is 

“Action_type [object ID]” (for example, “ListBox [LB123]”). 

• Select (action type): Use this drop-down list to select the object ID in which a selection will 

be made. This field must point to a valid object ID. If the project files for the document have 

been loaded, the list will contain the available objects. If the files have not been loaded, the 

object IDs need to be manually checked and entered. This is done either by checking the 

properties of the affected objects in QlikView Desktop or in a browser that has opened the 

document in question. 

• Selection method: Setting for how to randomize a selection, or if static selection should be 

performed. For static selections, the value that should be selected have to be provided (static 

selection values must be typed exactly as these are presented in the document). For 

randomized selections, the user can define whether a randomized selection should originate 

from seeded files (select the From file checkbox) or not.  
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• Min number of selections, Max number of selections: Sets the minimum and maximum 

number of elements that should be selected at a time (if possible). The number of selections 

at a time are randomized within the defined range, if the values differ between min and max. 

The most common use case should be one selection at a time (that is, default values). 

See Appendix A: Detailed script settings and actions (GUI) for additional information on how to 
configure actions.  

Recommendations and guidelines for script design 

There are some limitations and guidelines on where certain actions can and should be placed.  

Always use Timer Delay actions to simulate user think time between actions. If no timers are 

included in the script, each thread/user performs each action as soon as the previous action is 

finished, which is highly unlikely a real user would do. Having the timer delays between actions 

simulates the user looking at the result set of an action before deciding what to do next. 

Verify the validity of actions in the script: When an action is defined to trigger a certain object, it is 

crucial that the object is present for the simulated end user at the time. For example, a Fast Change 

action alters between different chart objects, which might be of both straight table and chart graph 

types. Make sure that subsequent actions trigger selections in valid objects. Performing a straight 

table selection when a chart graph is active or the other way around will return improper results. 

Using document chaining in the script leads to two or more documents being used, but only one 

document layout is read with the tools. It is therefore recommended to read the most relevant 

document layout, which is usually the one where most of the action is performed. Note that some 

actions, belonging to the other document, may be seen as invalid by the document layout read. 

A sub-loop (the TESTLOOP action) is a good way of generating load by repeating a set of actions 

multiple times. However, some things that must be considered are described below. 

Be careful when placing Change Sheet, Activate Minimized Object, Fast Change or Cycle actions in a 

sub-loop. These actions can be used in a loop, but consider the following first: 

• Change Sheet: It is valid to have several Change Sheet actions within a sub-loop, as long as 

the last and first Change Sheet actions in the loop are not for the same sheet. Otherwise the 

script will send the Change Sheet request for the same sheet that is already active, which will 

not return proper results. It is recommended to have the Change Sheet action outside of the 

sub-loop, and then add a sub-loop of actions that should be performed on that sheet. 

• Activate Minimized Object: Rules similar to those for Change Sheet apply for activating a 

minimized object. It is valid to include several Activate Minimized Object actions within a 

sub-loop, if each such action result in minimizing the other objects that will be activated in 

the loop. Otherwise, the script will try and activate an already active object, which will yield 

incorrect results. 

• Fast Change, Cyclic actions: As for Activate Minimized Object, it is important to know the 

state of the object after it has been fast changed or cycled. This is especially important if a 

selection should be performed later in that object. 

It is recommended to always have a Clear All action (not Clear Object) at the beginning of a 

sub-loop as this will enable proper selections for all iterations.  
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The TESTLOOP action is best utilized in two ways. It can encapsulate all actions in the script after 

Open Document. This results in fewer created sessions, but each thread/user might still generate a 

substantial amount of load as they repeat the scenario multiple times (except opening the 

document, which is responsible for creating a new session). See below for an example where the 

scenario will be repeated 10 times per thread/user.  
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Sub-loops can also be used to repeat actions on a specific sheet multiple times. The example below 

illustrates a scenario that navigates to the AccessPoint and opens a document. After opening the 

document, the user changes to a new sheet. All actions on the selected sheet are repeated five times 

before changing sheet and performing actions on the second sheet three times. The scenario is 

completed after the last iteration of the second TESTLOOP and either starts again from the 

AccessPoint or ends (depending on the parameters in the script settings).  

 

There are different randomization options available for some actions. The options are selected in the 

Selection method drop-down list for the action: 

• Randomize from all: This will randomize selections amongst all values contained in an object 

regardless of whether they are enabled (white, green) or disabled (grey). Note that this 

method should never be used on a document with Section Access. 

• Randomize from disabled: If you want the user to select different values in an object 

multiple times after each other, this is a good method to use in the script. Each selection is 
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made only from the disabled values (greyed in QlikView). If the Randomize from enabled 

option is used when selecting values in an object multiple times after each other, this would 

result in every second selection picking the already selected value (that is, deselecting the 

previous value). 

• Randomize from enabled: The most common option that a real user would perform. This will 

randomize amongst selections that are enabled (white or green values within the certain 

object in QlikView). It is recommended to primarily use this method. However, the number 

of values to randomize amongst is limited to 40. The values that are available depend on 

previous selections in the document. If this is deemed not enough to get proper random 

selections, use the Randomize from all method instead. 

Script Generation 
JMeter scripts can be generated in several ways, triggered either from the GUI or from a batch file. 

Generating from the GUI is described below, whereas information on batch generation can be found 

in Appendix D: Generating and Executing scripts in command line mode. 

Generating script from GUI 

To generate a script either use Tools > Generate Scripts or click the icon in the tool bar. A new or 

modified script file will also be regenerated prior to execution from within the GUI. 

 

Before generating a script, the test scenario must be saved. If the file has not been saved previously, 

you will be asked to save file before the script generation proceeds. A test scenario including all 

settings is saved as an XML document. The default folder for storage of XML test scenario definition 

files is the subfolder \SourceXMLs\. The JMeter script file is automatically named as the XML file, but 

with the file extension .jmx. The default folder location for storage of JMeter script files (.jmx) is 

..\ScriptExecutor\DestJMXs. 

During script generation, a window containing information about the progress is displayed. Console 

output is part of the script generation to indicate if the generation was successful or not. 

Unsuccessful script generation is usually connected to missing values. 

Note: It is recommended not to include blank spaces or underscores in the XML file name. The 

Analyzer tool needs the JMeter log file name to be properly formatted and the script name to be part 

of the log file name.  
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Executing JMeter scripts 
You can execute a script from the GUI either by clicking the Execute all scripts icon or by clicking 

Execute all on the Execution tab. If any changes have occurred in the script since it was last saved, it 

needs to be saved anew. 

 

If a script has been loaded and the Execution tab is opened, a popup appears, asking if the file should 

be saved and added to the execution plan.  

The Execution tab contains a Settings section that can be expanded, a section with a list of scripts to 

run and a section containing information regarding the scripts that should be executed. 

Settings 
Expanding the Settings section displays a textbox for the JMeter path. To execute scripts from the 

GUI, the JMeter installation path (bin folder) needs to be specified.  

 

The Settings section also contains an Advanced mode checkbox, which is for advanced users who 

know the options well. Enabling this mode allows the user to change the JVM heap size without 

opening the JMeter.bat file (see the Prerequisites.docx document for more details). It is defaulted to 

3072, but if 32-bit Java is installed, it should be set to 1280. If the Advanced checkbox is selected, you 

can add JMX (JMeter file format) scripts to the execution list by clicking Add. Select Print JDebug info 

to allow JDebug information from the tests to be printed when they are executed. Select Unique 



19 
 

JMeter log file to also generate a unique JMeter log file for each execution. These options should 

normally not be selected, but might be useful for troubleshooting. 

  

Execution 
As mentioned previously, execution can be started by clicking Execute all or the Execute all scripts 

icon. This executes all scripts currently added to the Execution tab. The scripts are started and run in 

parallel, each using its own JMeter instance. 

Add more scripts by clicking Add, or simply use drag and drop. Both XML and JMX versions of the 

script are accepted, but unless Advanced mode is selected only XML files will appear when browsing 

for scripts. Selecting an XML file always generates a JMX file (as this will be executed) as long as it 

does not already exist, but it will be put it in the correct folder, which is the main reason for limiting 

the selection.  

Selecting a JMX file does not lead to any error checking, but only to executing a previously created 

file. If any manual changes have been done in the JMX file, you should not load the XML file 

describing said test as this might regenerate the script and overwrite the manual changes. The 

output from the test will still be stored in /Analyzer/JMeterExecutions regardless of the location of 

the JMX file. 

If a script is selected, the settings for it appear in the Info tab. Note that information is only fetched 

for XML files.  

Right-clicking one of the scripts in the list displays additional options. An existing script can be 

opened in the Script Generation GUI, which allows for editing of the script properties and the 

scenario actions. It can also be opened in the JMeter GUI, which may be useful for troubleshooting or 



20 
 

if the script needs to be changed in detail with actions not currently supported by the tool. Each test 

can also be generated and run individually by selecting Generate or Run after right-clicking. 

 

When all scripts have been added and execution has started, additional tabs will be created next to 

the Summary tab. The Script Preparation tab displays script generation output for the currently 

loaded scenario. An additional tab will be created for each scenario to be executed and each will 

update continuously with results as the scripts are executed.  

Summary results are logged approximately every five minutes in the output window. When the 

results are written they will contain the number of requests, average response times, min/max 

response times and amount of errors. These results will be written as two lines, where the one 

containing a “+” in the beginning is the delta line (the results since last output) and the line with a “=” 

is the totals so far for the script. 
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Click Abort all to abort all scripts currently running. To stop an individual script, right-clicking its tab 

and select Abort. 

 

Log Collection 
After running a test, it is usually time to analyze the test results, which means that log files from 

various services are needed. The log files can either be copied manually to the required folders or 

you can use the log file collection helper. 

The log collection is intended as a helper, and cannot be guaranteed to find and fetch the files. 

Firewalls might hinder the tool to find the performance counters (server logs). In addition, the user 

that runs the collector needs administrator rights to the folders that contain the log files. Knowledge 

of what should be collected should be seen as a prerequisite to use the log collector.  

When a test has finished, a popup appears, asking if the log file collection helper should be launched 

(see below). The log file collector can also be started from the Tools menu. 

 

Once launched, the tool scans for log files relevant to the test, using input from the script (document 

URL and execution date). The tool will try to find paths to performance counters, event logs, session 

logs and the JMeter log file for the specified timespan. The timespan can be adjusted, and you can 

also change the server(s) that log files should be collected from. If anything is adjusted, this needs to 

be scanned by clicking Scan for the section that was updated. Adding a new QVS instance and clicking 
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Scan causes the tool to check for any log files on that newly added instance, and if anything is found 

it will show up in the Paths to log files window. 

 

Log file Collection main window, with found paths to all relevant log files 

If everything is found, all sections in the window are populated with information of where the log 

files are. The next step is to actually fetch the log files by clicking Fetch. Fetched files are put in a 

folder identified by the username and timestamp in the Analyzer folder. All files are put in the correct 

places according to the folder structure used by the Analyzer application (JMeter log files are put in 

JMeterLogs etc.). By default, the JMeter file is moved, whereas all other files are copied to the 

destination folders. 
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If anything goes wrong or log files are not fetched, the Log tab might indicate the issue. For example, 

the following error message is caused by not having administrator rights on the server. 

 

Analysis of test results 
The test results can be analyzed with the Scalability Results Analyzer tool, which is available at 

https://community.qlik.com/docs/DOC-15451.  

The logic of the Analyzer is built upon reading the log files that were recorded during a test execution 

(log files configured in accordance with the prerequisites). Analysis of the log files provides the ability 

to study trends and server utilization. However, for an estimate of the user-perceived response times 

and experience, manual measurements should be conducted.  

See the separate document in the Analyzer package for guidelines on how to use the Scalability 

Results Analyzer tool with test data. 

Complementary Manual Measurements 
To gain knowledge of the full response times including rendering, manual measurements should be 

performed. A browser in combination with an optional measurement method can be used to get a 

snapshot of the user-perceived experience. 

Perform the actions defined in the scenario and measure the time for each action to complete. The 

Scalability Center uses Fiddler, a proxy-based recorder, for this. When a measure of the user-

perceived response times during a certain load is desired, the performance measurements should be 

performed in combination with a load scenario. 

  

https://community.qlik.com/docs/DOC-15451
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Appendix A: Detailed script settings and actions (GUI) 

General 
This appendix describes how the script settings, variables and scenario actions should be set to get a 

functional script. If more information is required on the XML file structure, refer to the 

XMLTemplate.xml file, which is located in the \ScriptGenerator\SourceXMLs folder. 

Scenario actions 
This section lists all actions.  

Action Description/usage 

AccessPoint Navigates to the AccessPoint. No additional values are needed. 
Open Document Opens a document. No additional values are needed. 
Button Simulates a button object click. Specify the object ID of the button (for 

example, “BU01”). 

Change ContainerTab Allows switching the currently presented container object tab (menu). 
Specify the object ID and position ID. The object ID should be set to 
the object ID of the container object in which the tab should be 
changed. The position ID defines the tab to activate, starting with “1” 
for the first tab in the container object. Specifying a position higher 
than the available number of tabs results in the last tab being 
selected, and specifying “0” or nothing at all results in the first tab 
being selected. 
Note: This is a mandatory action if there are subsequent actions 
making selections in the corresponding container tab. 

Change Sheet Changes sheet in a document. Specify the sheet ID of the sheet (for 
example, “SH01”). 

Chart Zooms in on an area in a chart. Specify the object ID of the chart (for 
example, “CH01”). Choose if random values should be based on pre-
generated seeded files (From file is selected by default) or generated 
on the fly. If the chart is placed within a container object, specify the 
ID of the container object. 

Clear All Clears all current selections. 
ClearObject Clears all selections in a list box or multi box object. Specify the object 

ID. 
Select Excluded Selects the excluded (grey) values in a list box or table box. Specify the 

object ID. Note that this action can be used to make more than 8 
selections (which is the default limitation in the QlikView GUI). 

Select All Selects all values in a list box or table box. Specify the object ID. This 
action should be used with caution as it respects other selections, 
which means that only white values are selected. The Select All action 
also adapts to other selections (for example, if all values in an object 
for which Select All was used become white by clearing another 
object, all those white values are selected, which might impact the 
possible selections for other objects). Note that this action can be 
used to make more than 8 selections (which is the default limitation in 
the QlikView GUI). 
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Action Description/usage 
Select Possible Selects all possible (white) values in a list box or table box. Specify the 

object ID. In comparison to the Select All action, this action only keeps 
the values selected, which might impact subsequent selections. Note 
that this action can be used to make more than 8 selections (which is 
the default limitation in the QlikView GUI). 

Cycle Chart Simulates clicking a cyclic switch (which cycles either a dimension or 
an expression) in a chart. It switches to the next value of the Cyclic 
switch (exactly as a user clicking on a cyclic switch). Specify the object 
ID of the chart (for example, “CH01”) as well as position. Position 
defines the placement of the cyclic switch (hotspot) on which to click. 
The placing of the hotspots and the numbers they have depend on the 
amount of hotspots in the chart. In general, the placing is as follows: 
First hotspot = “southwest”, second = “southeast” and third = 
“northeast”. See the illustrations below for information on how the 
hotspots are aligned; the numbers in red indicate the assigned ID for 
each hotspot. 

 

Chart containing three hotspots 
 

 

Chart containing four hotspots 

Cycle StraightTable Simulates clicking a cyclic switch (which cycles either a dimension or 
an expression) in a straight table. It switches to the next value of the 
Cyclic switch (exactly as user clicking a cyclic switch). Specify the 
object ID of the straight table (for example, “CH01”) as well as the 
position. Position defines the placement of the cyclic object on which 
to click – it is either a column or row number depending on the 
straight table orientation, starting with 1 for the top/leftmost. 
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Action Description/usage 
Document Chaining Performs a document chaining, triggered by a button click. Specify the 

objected of the button. The document chaining performs a new Open 
Document action and all subsequent actions are performed in the 
new document. 

FastChange Switches the data presentation for Chart objects. Specify the object ID 
of the object to perform a fast change in (for example, “CH01”).  
Note: If further actions should be performed on a fast changed object, 
it is important to know the state (what is presented) after a fast 
change action has been performed, as the data presentation may 
switch between straight table and graph chart types. 

ListBox Selection methods:  

• Randomize from all 

• Randomize from disabled 
• Randomize from enabled 

• Static Selection 
Use this action to make a static or randomized selection in a list box. 
Specify the object ID (for example, “LB01”) and selection method. For 
randomized selections, choose if the random values should be based 
on pre-generated seeded files (From file is selected by default) or 
generated on the fly. For Static Selection, enter the value (visible text) 
that should be selected. Alternatively, if the underlying QlikView ID of 
the value is known, select ValueByID and enter the ID. The Min/Max 
number of selections define the number of values to select. 
Selections are made on elements next to each other. If the list box is 
placed within a container object, specify the ID of the container 
object. 

MultiBox Selection methods:  
• Randomize from all 

• Randomize from disabled 
• Randomize from enabled 

• Static Selection 
Use this action to make a static or randomized selection in a multi 
box. Specify the object ID (for example, “MB01”) and selection 
method. For randomized selections, choose if the random values 
should be based on pre-generated seeded files (From file is selected 
by default) or generated on the fly. For Static Selection, enter the 
value (visible text) that should be selected. Alternatively, if the 
underlying QlikView ID of the value is known, select ValueByID and 
enter the ID. The Min/Max number of selections define the number 
of values to select. Selections are made on elements next to each 
other. If the multi box is placed within a container object, specify the 
ID of the container object. 

SearchObject Performs a global search and makes a static or randomized selection 
from the search result. Specify the search string, object ID and 
selection method. If more than one value should be selected, modify 
the Min/Max number of selections. The search string can either be 
taken from a file or be specifically defined for each search. If it should 
be taken from a file, select Search from file and enter the file name in 
the search term input box. This file must be placed in the 
\ScriptExecutor\SupportFiles folder. 
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Action Description/usage 
Select Bookmark Selection methods:  

• Randomize 
• Static Selection 

Use this action to make a static or randomized selection from 
available Bookmarks. For a randomized selection, choose if the 
random value should be based on pre-generated seeded files (marked 
check box from file – default) or generated on the fly. For Static 
Selection, enter the visible text of the Bookmark to select.  

StraightTable Randomly selects one or more cells in a straight table. Cells are 
selected in a row. Specify the object ID (for example, “CH01”). Choose 
if random values should be based on pre-generated seeded files 
(From file is selected by default) or generated on the fly. The 
Min/Max number of selections define the number of values to select. 
Selections are made on elements next to each other. If the straight 
table is placed within a container object, specify the ID of the 
container object. 

TableBox Use this action to make a randomized selection in a table box. Specify 
the object ID (for example, “TB01”). Choose if random values should 
be based on pre-generated seeded files (From file is selected by 
default) or generated on the fly. The Number of columns/rows per 
selection define the area selected in table box. Selections are done 
from a randomly picked starting point and respect table boundaries. If 
the table box is placed within a container object, specify the ID of the 
container object. 

TextObject Simulates clicking a text object. Specify the object ID. 
Activate Minimized 
Object 

Activates an object that has been minimized. Specify the object ID of 
the object to activate (for example, “CH01”).  
Note: Unlike other actions, this action presents a list of all objects on 
the currently selected sheet. 

Add Note Adds a note on an object. Specify the object ID and the note text. You 
can use a text file as input for the note. In that case, specify the name 
of the text file in the input box. The default path for the file is the 
supportfiles folder.  
Note: This action is not available in QlikView 10. 

CloseSession Closes the session and simulates a user logout from within the 
application. 

Copy Object Copies an object. Specify the object ID of the object to copy. 

Create Bookmark Creates a bookmark with the name specified in the input box. This 
input box can be empty, in which case the name of the bookmark will 
be a default one. 

Delete User-added 
Objects 

Delete all user-added objects (that is, objects that have been created 
using copy/paste). 

Minimize Object Minimizes an object. Specify the object ID of the object to minimize. 
Paste Object Pastes a previously copied object. Hence, a Copy Object action must 

be performed prior to this action. 

Remove Bookmark Removes the bookmark specified in the input box. If no bookmark 
name is specified, a default bookmark suggested by the QVS is 
removed. 
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Action Description/usage 
Send to Excel Performs a send to Excel action on an object. Specify the object ID.  

Note: The action is initiated, which means that the XLSX file (QlikView 
12.20) or the XLS file (all previous QlikView versions) is generated on 
the server side and stored in the Export folder. The file is not 
downloaded. 

Export (CSV) Performs an export to CSV format on an object. Specify the object ID.  
Note: The action is initiated, which means that the CSV file is 
generated on the server side and stored in the Export folder. The file 
is not downloaded. 

Export (CSV) Container Performs an export to CSV format on an object. Specify the object ID. 
The data is compressed by storing the CSV file in a ZIP archive.  
Note: The action is initiated, which means that the ZIP file is 
generated on the server side and stored in the Export folder. The file 
is not downloaded. 

Toolbar actions Performs one of the supported actions in the toolbar (back, forward 
etc.). Specify the type of action to perform. 
Variants:  

• “CLEARSTATE” (clear all) 

• “BCK” (back) 
• “FWD” (forward) 

• “LS” (lock all selections) 
• “US” (unlock all selections) 

• “CS” (show/hide current selections) 
• “TOGGLENOTES” (show/hide notes) 

Timer Delay – 
GaussianTimer 

The Gaussian timer sets a random think time in the script. When the 
script reaches the Timer Delay action, it pauses for the amount of 
seconds specified. The delay will be a Gaussian distributed value 
(most of the time intervals occur near a particular value) with the 
Average parameter as the median value (and Deviation as deviation). 

Timer Delay – 
UniformTimer 

The uniform timer sets a random think time in the script. When the 
script reaches the Timer Delay action, it pauses for the amount of 
time specified. The Min parameter specifies the minimum amount of 
time for the delay. The Max parameter specifies the maximum 
amount of time for the delay. 

Timer Delay – 
ConstantTimer 

The constant timer sets a static think time in the script. When the 
script reaches the Timer Delay action, it pauses for the amount of 
seconds specified. 

TESTLOOP The testloop action is not so much a separate action as a collection of 
actions that should be repeated. Number of loops specifies the 
number of times to repeat the actions in the testloop.  
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Action Description/usage 
Placeholder Creates an “empty” placeholder action that needs to be edited within 

JMeter with a valid request and/or logic to support it. This can be 
used when generating a script that contains actions that are not 
supported or implemented as JMeter components. This can then be 
edited to send the correct request. 

Comment Used to create a commented line in the XML definition of the script. 
Specify the comment. The output in the XML will look like the 
following:  
<!—This is my comment--> 
It can be useful to keep track on what is happening in a rich script, but 
comments do not impact the script. In addition, comments do not 
carry over from the XML definition to the generated JMX script.  

Tips and tricks for creating scripts 
There are a few things to consider when adding a scenario in the QlikView Test Script Generator. 

The QlikView Test Script Generator uses the document layout to identify objects in the 

document/sheet. For example, when adding the Change Sheet action, the Select Sheet drop-down 

list contains all available sheets in the document with their names and object IDs. 

When a sheet is selected and a new action is added (for example, ListBox), only list boxes that are 

connected to the selected sheet are available for selection. If an action was chosen, but there are no 

objects available in the drop-down list, it means that there are no objects of this type on the selected 

sheet, or that the action is not connected to a sheet. 

Only one document layout will be read, so if the Document Chaining action is used in the script, it is 

recommended to read the layout of the document where most of the actions will be performed. 

Note that some actions, belonging to the other document, may be seen as invalid by the document 

layout read.  

Caution is advised if a new action needs to be inserted in-between existing actions. If the new action 

is a selection that refers to the same sheet as other selections, it will be correctly recognized. If the 

new action is a Change Sheet action, it should not be added in-between other actions for another 

sheet as this might break the script flow.  
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To simplify the overview, the following scenario images do not contain timers. 
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When creating a new scenario, empty actions should not be inserted in advance. If this is done, the 

actions will not recognize the document layout (that is, the actions might not be properly connected 

to the correct sheets). 

Example: 

Scenario one (correct) 

• In first action choose – AccessPoint 

• Create new action – set it to Timer of your choice. 

• Create new action – set it to Open Document. 

• Create new action – set it to Timer of your choice. 

• Create new action – set it to Change Sheet, and choose sheet from the drop-down list. 

Create a new action – set it to ListBox. In this case, the list box will be connected to the previously 

selected sheet, so in the drop-down list the list boxes present on the selected sheet should be 

available. 

Scenario two (incorrect usage – DO NOT try to create a script like this) 

• In first action choose – AccessPoint 

• Insert four new actions (this is wrong!). 

• Set the action below AccessPoint to a Timer of your choice. 

• Set the next action to Open Document. 

• Set the next action to Change Sheet. Choose a sheet from the drop-down list. 

Set the next action to ListBox. In this case, the drop-down list of list box objects will be empty. This is 

because an action was created before the sheet selection was done, so it cannot be connected to the 

sheet. 
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Editing existing XML file 
You can edit existing XML files for script generation. To edit an existing XML file in the QlikView Test 

Script Generator, select File > Open and then select the XML file to modify. A script file is opened and 

all previously saved actions restored.  

The script properties can be modified on the Properties tab (for example, concurrent users, 

iterations per user, ramp up, duration).  

On the Scenario tab, the script actions can be modified. To do that, specify the Project files folder. 

Click Browse to select the path to a folder containing document layout.  

In some cases, the project files change between tests (for example, the object ID changes for a 

particular list box or a sheet is removed from the document). The GUI highlights actions that do not 

match the project files in red (see below). 

 

It is necessary to remove faulty actions and create new ones that reflect the current document 

layout. You can add new actions and remove existing ones to create an updated script. Note that the 

same rules as for creating a new script applies if it comes to adding new actions in-between existing 

ones. 

To avoid overwriting the existing script, it is recommended to save the XML file with a new name 

(File > Save As) before creating the new script.  
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Appendix B: Load testing – A brief introduction 
To get reliable measures when performing load tests it is important to have an environment that is 

dedicated to load tests only (at least temporarily). Assuming that the goal with the load test is to 

investigate the performance of the application and not the infrastructure surrounding the servers 

hosting the documents, it must also be ensured that there are no routers or firewalls etc. that 

constitute bottlenecks. The load generator should therefore typically be positioned as close as 

physically possible to the server subject to the load test. An intermediate firewall may see a load test 

as a Denial of Service attack and block the generated traffic as a whole or parts of it. However, to 

perform performance measurements and measure how an end user will experience QlikView, the 

client for end user measurements should be physically placed in the network in the same position as 

typical users would be placed (see the figure below). 

 

Architectural view of clients’ position for user-perceived QoS and load generation 

Typically, the aim of a load testing session is to benchmark the capacity in terms of the number of 

clicks/s or measured response times when there are a certain number of users accessing the same 

document. The most critical and important part is then to produce a script that mirrors scenarios 

from reality. When creating a realistic user scenario, it is important to implement realistic inter-

departure times (that is, think times between clicks) for the requests from a certain user, as this has 

great impact on the generated load. Another challenging task is to create an average scenario that 

replicate the load generated by many users in total when scaled up.  



34 
 

Tuning the load can be performed in various ways. The three most common and obvious ways for 

doing this are: 

• Tuning the number of concurrent virtual users (referred to as threads in JMeter). 

• Tuning the number of requests within a user scenario. 

• Tuning the inter-departure times between adjacent requests. 

The second and third bullets above should be covered by the design of the test scenarios (that is, 

when defining a realistic scenario). This way, the only variable to tune during a load testing session is 

the number of virtual users. 
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Appendix C: Setting up Basic Authentication 
Basic Authentication (BA) is a way of identifying users without using Windows Authentication. It 

simulates different users accessing the AccessPoint and document.  

How to enable Basic Authentication 
ISS configuration: 

• Use the Server Manager to stop the ‘World Wide Web Publishing Service’ and ‘QlikView 

Server’ services. 

• Copy the file Authenticate_test_with_BA.aspx to the C:\Program 

Files\QlikView\Server\QlikViewClients\QlikViewAjax folder. 

Note: This is the default installation path. If QlikView has been installed in a different folder, 

the path \Server\QlikViewClients\QlikViewAjax must be available in the folder in which 

QlikView was installed. 

• Rename the original file Authenticate.aspx (to, for example, Authenticate.aspx.original). 

• Rename the file Authenticate_test_with_BA.aspx to Authenticate.aspx. 

• In Server Manager, go to Roles > Web Server (IIS) > Internet Information Services (IIS) 

Manager, unfold the Sites and Default Web Site section. Select QvAjaxZfc, double-click the 

Authentication icon. Set Windows Authentication to Disabled. Set Anonymous 

Authentication to Enabled. 

• Select QvAjaxZfc, switch to Content View, and refresh the folder. 

• Select the file Authenticate.aspx, right-click and select Switch to Features View. Double-click 

the Authentication icon. Set Windows Authentication to Disabled. Set Anonymous 

Authentication to Enabled. 

• In Server Manager, start the ‘World Wide Web Publishing Service’ and ‘QlikView Server’ 

services. 

QlikView Management Console configuration: 

• Go to System > Setup. Select the QlikView server and select the Security tab. Change 

Authorization to be DMS authorization. Click Apply to confirm the changes. 

• Go to Documents > User Documents, select the document against which the test will run. Go 

to the Authorization tab. Use the plus icon to add Recipients. Edit the newly added field. Use 

the Add users icon and select All authenticated users. Click OK to confirm. Set Access to 

Always, click OK to confirm. Click Apply to accept the changes. 
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Appendix D: Generating and Executing scripts in command line mode 
Although it is recommended to use the script generator GUI when creating and executing scripts, 

these actions can be done from batch/command line mode as well. 

Note: Check the Prerequisites.docx document for the necessary preparations before you start 

working with the QlikView Scalability Tools in command line mode. 

Generating a script in command line mode 
It can sometimes be time efficient to generate variants of a script where, for example, minor settings 

have been tuned directly in XML (for example, thread count or ramp-up time). After you have 

created an XML definition of the script, go one level up to the folder ScriptGenerator. Invoke the 

GenerateScripts.bat file from there, and it will open a cmd window.  

 

From the list you can see the available XML template(s) that can be found under the SourceXMLs 

folder.  

Enter the file name of your selection and press ENTER. The dialog will prompt you the XML file that is 

selected. Check that the file name is correct for the XML definition that you want to use.  

 

Enter the file name that you want to give to the JMeter test script file, which is the output from the 

Generator. Remember the rule of thumb that both the XML definition file name and the JMeter 
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script file name should reflect the QlikView document that will be tested. The file names should not 

contain any special characters, especially not underscores (“_”) or empty spaces.  

 

The dialog will prompt you to confirm that the file name you entered is correct and ask for your 

permission to proceed. If you choose YES, the Generator starts to create the JMeter script for you 

based on the XML definition you provided. If you choose NO, it will ask you again about the XML 

definition file name and the JMeter script name. Press ‘n’ to choose NO or ‘Y’ to choose YES and 

continue. 

 

During the generation of the JMeter script you should check the log entries and make sure that the 

generating process progresses as expected without errors. 

When the process is finished, press any key to close the cmd window. 

 

The script generator allows you to create one JMeter script at a time based on one XML definition 

file. To create more scripts, re-invoke the GenerateScripts.bat file and go through the steps again. 
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Executing a script in command line mode 
To execute one or more scripts from command line, invoke the file ExecuteTests.bat in the 

ScriptExecutor folder. A console window appears and the prompt lists all test scripts that you can 

select.  

Note: The scripts must exist in the ../ScriptExecutor/DestJMXs folder.  

 

 

Select the JMeter script(s) you want to run by entering the script name. The script executor accepts 

three types of input: 

• If you want to run a specific test script, enter the full name of the script. 

• If you want to run a group of test scripts starting with the same name, use the star key (‘*’) 

combined with the common name (for example, to select Films01.jmx, Films02.jmx and 

Films03.jmx, enter “Film*”). 

• If you want to run all test scripts, just enter ‘*’. 
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The prompt lists all selected JMeter script(s) that will be executed. Check that the selection is correct. 

If it is incorrect, press ‘n’ to re-enter the script name again. If it is correct, press ‘Y’ or ENTER to start 

the test execution. 

Note: If you have selected more than one JMeter script to execute, the executor starts multiple 

instances to execute all the scripts. A pop-up console window appears for each instance of the 

JMeter script. 

 

Wait for the test execution to finish in all consoles. Check the main console window and each JMeter 

console window that no major errors or failures have occurred. When the test is done, press any key 

to close the console window. 
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Appendix E: Assertions 
Assertions are used in the QlikView Scalability Tools to provide feedback to the user (for example, if a 

script tries to make a selection in an object that does not exist, an error is reported). The assertions 

also facilitate the handling of timeouts, so that actions that time out are marked as failed.  

The following actions support assertions: 

• ListBox 

• Chart 

• MultiBox 

• StaightTable 

• TableBox 

• Activate Minimized Object 

• Button 

• Change container Tab 

• Cycle StraightTable by click 

• Cycle Chart by click 

• Text Object 

• Add Node 

• Copy Object 

• Send to Excel 

• Minimize Object 

Note: Not all actions are supported (for example, selections within container objects).  
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